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ABSTRACT 

It was the most popular and integrity part of computational data based 

screening method of compounds in Pharmaceutical Research for drug 

Discovery efforts. The molecular docking is an important part of 

virtual screening, means “Ligand-based Screening” to find out the 

active compound as a template and also focus on comparative 

molecular similarity analysis of compounds with known and unknown 

activity by algorithm method. Docking  is one of the best data-based 

screening methodology of virtual screening for ligand which 

minimized the works cost by filtering and also helps to predicted the 

toxicity study for designing the formulation or synthesis of New 

Chemical Entity(NCE) in now a day of Pharmaceutical Research 

Developments.  

Key Words: Molecular docking, Computational chemistry (Insilico Methods), Scoring,  

Docking soft wares. 

 
INTRODUCTION 

Molecular docking is an important tool of molecular modeling system which provides to 

teach us the ligand-protein interaction through four force fields by orientation and translation. 

It is also welly known as a “Ligand-based Screening Method” in which a small organic 

molecule having drug liking property or drug molecule is interacting with target protein or 

receptor through intra or inter molecular binding reasons like hydrogen bonds, vandar waal 
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bonds etc. This binding conformation will be confirmed by each translation and orientation of 

ligand-protein complexations and it was observed in visualizing docking windows like Hex-

6.3, Argus Lab. 4.0.1 and MVD 5.0.5 by algorithm methods. 

 

 
   Ligand                                                                                            Receptor / target protein 

  

   
                          

Ligand shaped cavity of target protein        protein - ligand docking figure 
(Intermediate stage of docking) 
                                  

                                                       H- Bond 

       Interaction ligand-protein by H-bonding                                                                                                                 
     

 

 

                                                                Fig-01 

Each iteration of ligand-protein bond complexation will be predicted the binding free energy 

which is known as pose energy of that conformation. The binding free energy will be 

depended in the shape or searching space of cavity of protein or receptor and the negative 

geometry of complexed pair of ligand-protein will be reflected the minimum binding free 

energy. This minimum negative binding free energy is predicted the best pose of that stable 

conformation which may or may not be reflected towards the biological indices.  

Designing 
Docking 
Steps 
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Various computational software methodologies were already used for explaining the ligand-

protein or protein-protein or protein-DNA interaction for designing the geometrical 

conformations of those bond complexations. Among of them, few software like Hex 6.3, 

ArgusLab.4.0.1 and MVD 5.0.5 were reflected its knowledge to us for designing and 

described the developing methodologies of molecular docking systems. the developing 

methodologies of molecular docking systems.        

 

COMPUTATIONAL CHEMISTRY 

Basic concept of docking1 

Docking" is defined as the identification of the low-energy binding modes of a small 

molecule, or ligand, within the active site of a macromolecule, or receptor, whose structure is 

known. A compound that interacts strongly with, or binds, a receptor associated with a 

disease may inhibit its function and thus act as a drug. Solving the docking problem 

computationally requires an accurate representation of the molecular energetic as well as an 

efficient algorithm to search the potential binding modes. Shortly it is known as the 

“Computational simulation of a candidate ligand binding to a receptor”.  

Applications:  

 predict binding modes of small molecule-protein complexes  

 search databases of ligands for compounds that inhibit enzyme activity  

 search databases of ligands for compounds that bind a particular protein  

 search databases of ligands for compounds that bind nucleic acid targets  

 examine possible binding orientations of protein-protein and protein-DNA complexes.  

 help guide synthetic efforts by examining small molecules that are computationally 

derivatized  

 many more ….. 

 
Ligand or guest or key1 

It is the complementary partner molecule which binds to the receptor. Ligands are most often 

small molecules but could also be another biopolymer. 

Character  

 It should be chemically active and having drug like property. 

 It has definite geometrical shape, size and surface area. 

 It has must contained flexible bonds (soft and rigid bonds). 

 It has a capacity to accept and donate the electrons. 
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Receptor (host or lock or Macromolecule or target protein)1 

The "receiving" molecule, most commonly a protein or other biopolymer is known as 

receptor.  

 
Binding mode1 

The orientation of the ligand relative to the receptor as well as the conformation of the ligand 

and receptor when bound to each other is known as binding mode. 

 
Pose - It is a candidature of ligand binding mode.  

Scoring – The process of evaluating a particular pose by counting the number of favorable 

intermolecular interactions such as hydrogen bonds and hydrophobic contacts of ligand is 

known as scoring. 

 
Ranking – The process of classifying which ligands are most likely to interact favorably to a 

particular receptor based on the predicted free-energy of binding. 

 
Molecular Docking (2, 3) 

Docking is an important part of drug designing field of molecular modeling system in which  

the orientation by means of interaction through H-bond or Vander Waal force of one 

molecule (ligand) to a second molecule(macro molecule or target protein) were bound with 

each other to form a stable complex. The orientation is directly referred to the strength of 

bond association or bond affinity between these two molecules and also predicted the scoring 

functions. The scoring function is directly influence the biological activity of that relevant 

molecule Docked. 

       Docked Figure-02: small ligand molecule with target protein through H-bonding 

 

 

 

 

 

 

 

 

 
Figure-02: small ligand molecule with target protein through H-bonding 

H- Bonding 
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Molecular docking can be thought as a “Lock and Key theory” in which the number of 

different volume of cavities are present inside the target protein and are acted as Lock . While 

the small molecular volume of ligand or drug is acting as a key which is fitted in that cavity 

by orientation. The main focus the molecular docking is to be recognized the optimizing 

conformation and relative orientation of  protein and ligand  which minimized the free energy 

of the all system and will be  predicted the best fitting area to define the best pose of  ligand. 

The best pose of the ligand reveals the better biological activity of that compound.    

 
 

        

 

 

 

 

 

 

 

Fig.03: “Lock and Key Theory” (Ligand fixed in a cavity of target Protein) 

 
Docking Approaches (4,5,6) 

Particularly more than two popular docking approaches are utilized for dock preparation of 

ligand and protein molecules. Such are 

 Matching of surface technique in both ligand and protein. 

 Stimulation of docking process by pairing of ligand – protein interaction energy is 

calculated.  

 The hydrophobic feature of protein in the main-chain atoms. 

 Fourier shape descriptors technique. 

These approaches have significant advantages as well as some limitation. These are 

 
Shape(7,8,9,10)  

The shape or surface descriptors are the complementary features of geometrical matching for 

ligand and protein to make them dock able. In case of receptor, the molecular surface is 

described in terms of its solvent accessible surface area while the molecular surface of ligand 

is described in terms of its matching surface descriptions. The two surfaces amount are 

Cavity 

Ligand 
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needed for shape matching descriptions that may be helped to find out the pose of docking of 

target and ligand molecules. The shape complementarily methods can be quickly scanned 

through the several thousand ligands in a matter of seconds and figure out the actual active 

site of protein for binding. 

 
Stimulation (11) 

The stimulation is an important main part of docking process in which the ligand and protein 

are separated by certain physical distances. So that the ligand find its active site inside a 

target molecule (protein) after  moving around the certain changing pose of conformational 

position in 3D space. The changes of conformation of ligand may be occurred due to 

flexibility and torsion of bond by moving in the mean of translations and rotations.  Thus 

each conformational move in 3D space of ligand induces the total energy cost of the system. 

This is known as optimal energy of the system. Now a day the latest technique is used for the 

detection of optimal energy pose by grid-base which is also based on translation and rotation. 

The docking can be stimulated or gridded between 

 Target protein (receptor) / small ligand. 

 Protein / peptide. 

 Protein / protein. 

 Protein / nucleotide. 

 
Mechanics Of Docking11 

It was the structure based process of interaction between x-ray crystallographic structure of 

protein (derived from bioinformatics’ centre) and potential uploaded ligand through H-

bonding , vandal Waal and steric factors. These are successively organized by algorithm 

method which is finalized the scoring function of docking. Otherwise the docking program is 

depending upon the algorithm and scoring functions of ligand.    

 
Search Algorithm12 

It is the current computational based theory of all possible orientations and conformations of 

target protein paired up with ligand. It is impossible to exhaustively explore the searching 

space for all possible distortion of each molecular conformation by rotational and 

translational orientation of ligand to the relative protein. In the docking program, most of the 

ligand was set as flexible. While several approaches of protein were considered as flexible. 

Each snapshot pair of protein- ligand is referred as a pose.  
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Struct. Of                                                        data base of small molecule 
 Protein 
target  molecule 
 
 
docking                                                     finding active site 
into site 
 
 
 
 
 
 

 

 

Fig.04:design and experimental testing of algorithms 

 
A rigorous search algorithm will be exhaustively elucidating the all possible binds mode of 

ligand-target protein. All six degree of translational and rotational freedom of the ligand 

would be explored along with internal conformational degrees of freedom of ligand-protein. 

However, this is impractical due to the size of the search space. A simple system comprising 

a ligand with four rotatable bonds and six rigid body alignment parameters will be estimated 

in the searching work space. The alignment parameters are used to position the ligand relative 

to the protein in a cubic active site measuring 103oA3. If the angles are considered in 100 

increments and translational parameters on a 0.50A grid, their approximately 4x108rigid body 

degree of freedom to a sample which is corresponding to 4x1016configurations of the four 

rotatable torsions to be recognized in the searching space and the 10 configurations of the 

ligand-protein grid will be estimated within a second. Thus variety of conformational 

strategies of ligands were applied to the proteins, are 

 Systematic or stochastic torsional searches about the rotatable bonds. 

 Molecular dynamics stimulation. 

 Genetic algorithm to evolve new low energy conformations.  

  
Ligand Flexibility13 

This is one of the main part of docking system in which ligand gives it conformations during 

the bind formation with the cavity of protein and also point out the force field energy of that 

reasonable conformation is known as pose energy.  

Structure determination 

New inhibitor design 
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Ligand RMSD14,15 

The root mean square distance (RMSD) values were reported by three main approaches when 

"calculate_rmsd = yes". These values can be found in the header of the output MOL2 file or 

docking out file.  

(1) Standard heavy-atom RMSD (HA_RMSDs): In this case the standard pair-wise RMSD 

can be calculated between the non-hydrogen atoms of a reference conformation a and a pose 

conformation b for a ligand with N total heavy atoms of index i. 

                          
If the HA_RMSDs is "-1000.0", then there is an inconsistency in the number of heavy atoms 

between the reference and the docked conformer. 

(2) Minimum-distance heavy-atom RMSD (HA_RMSDm): The measurement of this case is 

based on the RMSD implementation used in Autodock Vina, or MVD 5.o.5 software, which 

does not explicitly enforce one-to-one mapping. Rather, atom pairings between reference 

conformation a and pose conformation b are determined by the minimum distance to any 

atom of the same element type, and it may be an under-prediction of the true RMSD.  

 

 
(3) Hungarian (symmetry-corrected) heavy-atom RMSD (HA_RMSDh): The final RMSD 

implementation is based on an O (N^4) implementation of the Hungarian algorithm.The 

algorithm solves the optimal assignment between a set of reference ligand atoms a and a set 

of pose ligand atoms b of the same size. For all groups of atoms of the same Sybyl atom type, 

a cost matrix M is populated where each matrix element mij is equal to the distance-squared 

between reference atom ai and pose atom bj. The Hungarian algorithm is used to determine 

one-to-one assignments between reference and pose ligand atoms such that the total distance 

between atoms is minimized. The new assignments c(i) are fed into the standard RMSD 

function in order to compute a symmetry-corrected RMSD. If the HA_RMSDh is "-1000.0", 

then there is an inconsistency in the number of atoms of at least one atom type between the 

reference and the docked conformer.  
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Receptor Flexibility16 

It was the most sophisticated computational work of computer-assist drug designing during 

the docking period in which receptor was considered as flexible. A single fixed conformation 

will be obtained if the structure of protein was x-ray crystallographic in nature. The negative 

folded (posed energy) state of protein is characterized by collection of energetically 

equivalent conformations. If the condition of conformation structure of protein would be 

changed, as a result the folded energy will be shifted to another environment and introduction 

of ligand also changed with respective conformation. According to the binding conformation 

of the receptor may already be present in the ensemble of the protein conformations and 

ligand does not actively deform a fixed state of the protein, as generally inferred from 

‘induced fit’ model.  

 
Scoring Function (17, 18) 

Scoring function is a mathematical method of virtual screening which predicted the non-

covalent interaction between two molecules after docking of them. Normally a small organic 

molecule having drug liking property or drug molecule (ligand) and second one is 

biologically active target molecule of drug such target protein or receptor (which is derived 

from Protein Data Bank.). These scoring functions have also been obtained between the 

interactions of protein-protein or protein- DNA molecules. 

Always scoring function has been giving the pose input of favorable binding interaction 

ligand-protein. Most scoring functions are physical-based mechanics force fields that 

estimate the energy of poses and a low (negative) energy indicates the stable system which is 

a liking ligand- protein bond complexation.  Actually the scoring function is composed of 

three different aspects that relevant to docking and design: 

 Ranking of the configurations generated by docking search for one ligand interacting with 

given target protein. i. e. detected the best pose energy or best free energy.  

 Ranking of different lignads with respect to the binding to one protein. i.e. prioritizing the 

binding affinity of ligand towards the protein. 

 Ranking of one or different lignads with respect to their binding affinity to different 

proteins. This aspect is an essential and specific as consider. 

Scoring methods can range from molecular mechanics force fields such as HEX: 6.3, Argus 

Lab: 4.0.1, MVD: 5.0.5, AMBER and OPLS OR CHARMM through the empirical free 

energy scoring function or knowledge based function. The currently available docking 

method utilizes the scoring function in one of two ways. The first approach uses the full 
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scoring function to rank a ligand protein conformation. The system is then modified by 

search algorithm and same function is applied to rank the new structure.  

 
Docking method is a popular technique of molecular modeling to study the drugs excipient 

interaction which helps to visualize the types and sites of interactions in computer monitor. It 

also be reported study of various amino acids unit combine to get the cavity which has stable 

conformation with minimum energy. The cavity depth, diameter of a wider and narrower rim 

were calculated and compared with the literature values using DTMM package. 

 

 

 

 

 

 

 

 

 

 

 
DOCKING SOFT WARES 

Auto Dock19 

Auto dock is one of most cited molecular docking software in the earlier investigation of 

research fields for developing the ligand-protein interaction to finding the drug-likeness 

property of a molecule. Otherwise it also called as molecular activity developer software. The 

Auto dock consists two main soft ware programs such are   

 For docking of the ligand to a set of grids describing the target protein. 

 Auto Grid for pre-calculating these grids. 

 
Auto dock Tools 

 Preparing the Files 

 .Editing the Protein PDB File with Auto Dock Tools (ADT)  

        Force field based 
       Empirical  Knowledge -based 

 Fresno X-score 
LUCID Chemscore 

F-SCORE   Score 

    PMF 

  SMoG 

Drug score 

   Dock  

Auto Dock 

D-SCORE 

      GOLD   

    G-score 

Agl LAB MVD Hex 6. 3 

     Scoring Functions 
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 Preparing the Ligand File with ADT. 

 Flexible Residues in the Protein 

 Further Preparation of the Protein Files 

 Open the Grid Options 

 ready to run AutoGrid 

 prepare the Docking Parameter file. 

 Running AutoDock. 

 

 

 

 

 

 

 

 

 

 

 

 

 

               

 

 

 

Preparing the Ligand 

                  Make sure the ligand has all hydrogens added before working with ADT 

 

Toggle the "Auto Dock Tools" button 

              
Opening file: Ligand → Input → Open → All Files → [choose file] →Open 

 
 

  Define torsions: * Ligand → Torsion Tree → Detect Root (this is the rigid part of the 

ligand) * Ligand → Torsion Tree → Choose Torsions → [either choose from the viewer 

                   AUTO DOCK TUTORIAL FLOW CHART20 

               PREPARATION OF PROTEIN FILE 

Opening file:  
[Right-click PMV 
molecules]…….choose file 

Color by atom:  
[Click ◊ under "Atom"] 

Eliminate water: Select →Select from string 
→ [write HOH* in "Residue" line and * in 
the "Atom" line] →Add → Dismiss → Edit 
→ Delete → Delete Atom Set. 
 

Find missing atom and repairing them: File → Load 
module → [Pmv; repair Commands] → Edit → Misc. 
 → Check for missing atoms → Edit → Misc. → Repair  
missing atoms. 
 

Add hydrogen’s: Edit → 
Hydrogens → Add → [choose 
"All hydrogens","no bond order", 
and "Yes" to renumbering] 

Hide protein:  [Click on the gray  
     Under "show Molecules"].  
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specific bonds, or  use the widget to make certain bond types active (rotatable) or inactive 

(non-rota table). Amide bonds should NOT be active (colored pink)] → Done. 

 Ligand  → Torsion Tree → Set Number of Torsions → [choose the number of rotatable 

bonds that move the 'fewest' or 'most' atoms] 

 

Save ligand file: * Ligand → Output → Save as PDBQT → [save with L. pdbqt]. 

            

      Hide the ligand, as explained in (A5) for the protein 

 
 
Preparing The Flexible Residue File  

(Note: if you are planning rigid docking, ignore this section and do the following: Grid → 

Macromolecule → Open → [choose RH.pdb]. Auto Dock will automatically add charges and 

merge hydrogens. Save the object as RH. pdbqt and move to section D.) 

 

Flexible residues → Input → Choose molecule → [choose the original protein R.pdb] → Yes 

to merge non polar hydrogens (Auto Dock assigns charges + atom types to R.pdb, and 

merges nonpolar hydrogens). 

 

Select the residues to be flexible: Select → Select from string → ARG8 → Add → Dismiss. 

 

Define the rotatable bonds: Flexible residues → Choose torsions in currently 

Selected residues → [click on rotatable bonds to inactivate them or vice versa]. 

 

Save the flexible residues: Flexible residues → Output → save flexible PDBQT → [save as 

R_flex. pdbqt]. 

 

Save the rigid residues: Flexible residues → Output → save rigid PDBQT → [save as 

R_rigid.pdbqt. 

Delete this version of protein: Edit → Delete → Delete Molecule → [choose 

                            protein (R)] → Delete → Dismiss] 
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Running Auto Grid calculation 

Open the rigid protein: Grid → Macromolecule → Open → [choose the rigid protein] → Yes 

to preserving the existing charges]. 

Prepare grid parameter file: Grid → Set Map Types → Choose Ligand →[choose  the ligand 

already opened] → Accept 

 

Set grid properties: Grid → Grid Box → [Set the grid dimensions, spacing, and center] → 

File → Close Saving Current. 

 

Save the grid settings as GPf file: Grid → Output → Save GPF → [save as R.gpf]. 

[Make sure the AutoGrid executable is in the same directory as the input 

files].       

Running: Run → Run AutoGrid → [make sure the program name has the right path, and that 

it is where the input files are] → Launch → [in the command prompt prompt, type "tail –f 

hsg1.glg" to follow the process] (Note: the AutoGrid calculation can be started directly from 

the command prompt by typing "autogrid4 –p hsg1.gpf –l hsg1.glg &") 

 
Preparing The Docking Parameter File (.Dpf) 

 

Specifying the rigid molecule: Docking → Macromolecule → Set Rigid Filename → [choose 

R_rigid.pdbqt]. (or RH. pdbqt for rigid docking) 

Specifying the ligand: Docking → Ligand → Choose → [choose L.pdbqt] → [here you can 

set the initial location of the ligand] → Accept. 

Specifying the flexible residues: Docking → Macromolecule → Set flexible Residues 

filename → [choose R_flex.pdbqt]. 

Setting the parameters for the chosen docking method: Docking → Search Parameters → 

Genetic Algorithm → [for 1st time, use the short number of evaluations (250,000), and for 

other runs choose the medium or long] → Accept. 

 
Setting docking parameters: Docking → Docking Parameters → [choose the defaults]. 

  

Specifying the name of the ligand dpf file to be formed, containing the docking instructions: 

Docking → Output → Lamarckian GA → [type L.dpf]. 
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Confirming the details of docking: Docking → Edit DPF → [make sure the right ligand pdbqt 

file name appears after the word "move", and that the right number of active torsions is 

specified]. 

 
Running Autodock 4 

[Make sure the Auto Dock executable is in the same directory as the macromolecule, ligand, 
GPF, DPF and flex files (in case of flexible docking)]. 

                                               

Running: Run → Run Auto Dock... → Launch 

WHEN RH AND LH ALREADY EXIST.  

 
Protein 

Grid → Macromolecule → choose RH.pdb → (charges & atom types assigned, nonpolar 

hydrogen merged) → File → save → write PDBQT → save as RH.pdbqt. 

 
Ligand 

Ligand → Input → Open → All Files → choose LH.pdb → (charges & atom          types 

assigned, no polar hydrogen merged) → save as LH. Pdbqt. 

 
Setting Docking parameters 

Docking → Macromolecule → Set Rigid Filename → choose either RH.pdbqt or 

RH_rigid.pdbqt → Docking → Ligand → Choose → choose LH.pdbqt → set the rest of the 

docking parameters. 

                                   Running docking simulation. 

                                      Viewing Docking Results 

 Reading the docking log file (.dlg) [Toggle the "AutoDock Tools" button]. ____ Analyze → 

Dockings → Open → [choose L.dlg].   ______   Analyze → Conformations → Load → 

[double-click on each conformation to view it on screen]. 

 
Visualizing docked conformations 

1. Analyze → Conformations → Play... (Note: & allows changing the ligand's color). 

Hex 6.321 

Hex is an interactive superpostioning molecular graphics program for calculating docking 

modes of pairs of protein and DNA molecules. it can also be calculated protein – ligand 

docking, assuming that the ligand is rigid through spherical polar Fourier (SPF) correlations 
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to accelerate the calculations in their 3D shapes. In Hex’s docking calculations, each 

molecule is modelled using 3D expansions of real orthogonal spherical polar basis functions 

to encode both surface shape and electrostatic charge and potential distributions. it represents 

the surface shapes of proteins using a two-term surface skin plus vander Waals steric density 

model, whereas the electrostatic model is derived from classical electrostatic theory. (Protein 

Docking Using Spherical Polar Fourier Correlations Copyright c 1996-2010 David W. 

Ritchie). 

 
Argus Lab 4.O.122 

A molecular modeling, graphics, and drug design program, contains Argus Dock which is the 

new drug docking code referred to both the GA Dock and Argus Dock docking engines, 

provides the Score scoring function with a preliminary set of parameters of following 

features: 

 Ribbon rendering for proteins : with several coloring options. 

 Solvent accessible surfaces. 

 Display bumps and hydrogen bond monitors between ligands and protein targets 

Gaussian 98 & Gaussian 03 interfaces and are automatically added to the Calculation 

results in the Molecule Treeview. 

 Molecule Treeview window: Molecule Treeview shows a treeview representation of the 

molecule and saves results of calculations that you have run. You can right-click on many 

calculated properties and select "render" or "animate" to see them on the screen. 

 Builder Toolkit window: This window shows the palette of atoms, rings, and amino acids 

you can attach to the cursor and place in the molecule window. 

 QuickPlot buttons for HOMO, LUMO, and ESP-mapped density surfaces. One click and 

all the essential calculations and surface preparation are done for you and the surface is 

rendered to the screen. 

 Query the PDB database: download and display PDB files in one click. 

 Calculation results and properties are saved to the Molecule Treeview. 

 Docking results including poses that are renderable (right-click on a pose icon to see). 

 UV/vis excited state results: by table and individually by excited state. 

 Molecular orbital table 

 Dipole moments (ground and excited state) 

 Transition moments (length and velocity operator) 
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 Magnetic moments 

 Mulliken, ZDO, Qeq charges 

 Animate normal modes with a single click 

 Thermochemical results from Gaussian calculations 

 Copy/Paste Calculation results or properties to the Windows clipboard for easily adding 

to other Windows applications like Word or Excel. Right-click will also give you the 

option of saving to a formatted text file. 

 Electric Field: SCF and CI, EHT, AM1, PM3, MNDO, ZINDO 

 Display XYZ Cartesian axes. 

 Orient the molecule in absolute coordinates and orientation. 

 More extensive Atom Labeling including chiral centers. 

 Invert chiral centers. 

 Peptide builder : Easily build alpha helices, beta strands or specify the phi/psi angles 

yourself. 

 Improved settings: Lighting, atom & background colors, electric field, display, and Quick 

Plot settings. 

 Render peptide backbone as segments to simplify the display of large proteins. 

 Set render mode and color for sets of atoms, residues, and user-defined groups. 

 Color by molecule, by atomic number, by amino acid polarity, or user defined colors. 

 Depth cueing. 

 Turn on/off the use of fast-rendering during molecule moves. 

 Make user-defined groups of atoms. Perform actions on these groups, such as selecting all 

neighbors’ atoms or residues within a given distance. 

 Improved support for hiding/showing complex sets of atoms, residues, and user-defined 

Groups. 

 PDB files: improved support for atom and residue typing. 

 Quick torsion and Quick bond length adjust (see Tips & Tricks). 

 Performance enhancements and reduced memory footprint in handling systems with lots 

of rings. 
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             HEX 6.3                                  ARGUS LAB. 

 

  

 

  

  

 

 

  

 

 

  

  

 

  

 

  

  

  

 

  

  

 

 

  

  

 

                                             

 

 

 

 Flow chart Representation of  Hex 21and ArgusLab22 molecular docking  

Pdb format of ligand Pdb format of  protein 

Paste into Hex  
     example 

Open the Hex6.3 by   
double click 

Select 
Ligand 
Second 

Selected 
Protein 
molecule 
   First 

Both are seen in Hex 
Visualized window 
 

Control -----select dock---docking window              
  comes out 

Change the parameters, soln=500, 
Sub step=1or2, steric scan & final 
                     Search < 30 
 

Press active bottom      
docking   start 

Go to….file---- save…. Both In 
Hex example name. 

Open the save file by click on. 

Click on treeview of left 
topof window 

Click on the +point residue 

Click on selected amino 
acid which was found 
from q-site finder. 

Select the amino acid… 
right click on…click on 
“make a ligand from 
residue”and  named it 

Select the amino acid… 
right click on….click on 
“make a group from 
residue”… tick mark on 
binding box and named it. 

Click on residue----miscellaneous 
…open the group to see whether 
both amino acids are present  in 
the group or not. 

Click on calculation ……selected 
docking. As result docking 
window is comes out. 

Put the ligand in box one and put the binding 
group name in box two. .. Pressed activate key 
as a result docking will be started. 

Go to calculation---click on…get the docking result and right click on best 
pose …selected display…..result the  best pose energy will be seen in visual 
window.  File-….click on save as….name it……saved in AGL format. 

Go to the file of 

Hex 6.3 window  
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Molegro Virtual Docker23 

Molegro Virtual Docker (MVD) is an integrated Computational modeller of modern drug 

design environment for studying and predicting how ligands interact through hydrogen bond 

with macro molecules. The identification of ligand binding modes is done by iteratively 

evaluating a number of candidate solutions (ligand conformations) and estimating the energy 

of their interactions with the macromolecule. The highest scoring solutions are returned for 

further analysis. MVD requires a three-dimensional structure of both protein and ligand 

(usually derived from X-ray/NMR experiments or homology modeling). MVD performs 

flexible ligand docking, so the optimal geometry of the ligand will be determined during the 

docking. 

 
Protein- Ligand Docking 

Predict how small flexible molecules interact with a protein receptor and Screen databases for 

potential drug candidates or refine existing leads. 

 Predict potential binding sites. 

 Protein binding pocket flexibility. 

 Visually inspect docking predictions with relevant interactions. 

 Repair, mutate, or minimize side chains before docking. 

 Displaceable water model. 

 Import and export of industry standard file formats (PDB, Mol2, SDF). 

 Automated preparation of input structures. 

 
            

 

            

            

            

            

            

            

            

            

           

FLOW CHART DIAGRAM OF MOLEGRO VIRTUAL 
DOCKER 

Open the MVD visualized 
window by double click on. 

Go to file…select import…Select ligand(pdb)..  
preparation….press import  bottom. 

[Same procedure apply on target protein] 

Go to workspace…select ligand…right click on.. select fit for screen. 
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Go to file.. select import…select protein…. Preparation (only protein and other mols are 
replaced by putting the tick mark on click in the box.)….. press import bottom. 

Go to docking…..click on “docking wizard”… window 
Comes out. 

Put the ligand name by pressing the right side       
bottom of   box…….press next bottom. 

Put the cavity volume by pressing  bottom…..press 
next bottom……again pressed next bottom. 

Pressed “start bottom” as  a 
result docking is started. 

After finished the docking….. press “best five posed energy” 
And these docking poses are select according to RMSD.  

Rotate the ligand by the help of mouse and creates a space for ligand inside the 
protein. Then right click….select fit for screen. 

Omitted ligand by click on box…… select protein &right click on… select create surface. 

Omit surface by click on box….click on ligand box…..click on protein 
box….go to preparation….click on cavity and put value (5-10)….press ok.  

Go to the work space,click on it…. Choose a cavity volume w.r.t .ligand 
volume……other volumes are omitting by click on box. 

Go to view….click on reset view…….again go to view…..click on docking view. 
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SIGNIFICANCE 

The binding interaction between of a small organic molecule (ligand) with enzymatic protein 

may result in activation or inhibition of the enzyme. If the protein is receptor, ligand binding 

may be resulted in agonist or antagonist. Docking may be applied to: 

 The complexed ligand-protein orientation will be given the scoring function of ligand in 

Hit representation of insilico method. 

 The docking can be optimized the ligand orientation conformation and formed the stable 

configuration which is referred to best pose of ligand and it will be predicted the certain 

biological activities. 

 The docking method is helped to search the estimate of binding affinity of ligands toward 

the target protein.  

 Understanding the binding mode principle for optimizing the standard leading molecule. 

 
CONCLUSION 

Molecular docking is one of the most popular and user friendly computational technology 

which helps in investigating, interpreting, explaining and identification of molecular 

properties by using of three –dimensional structure. Molecular docking also tries predict the 

structure of inter molecular interaction complexation formed between two or more 

constituent molecules. This techniques are applied in computational chemistry, computational 

biology and material science for studying the molecular system ranging from small organic 

molecule to macro (large) biological molecules and materials assemblies. Presently, most of 

the docking programs are used to stimulate the binding of a flexible ligand to a rigid biology 

receptor.  This model does not reflect the actual physical process of bonding but eventually it 

prevents the correct identification of potential drug candidatures.     
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